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Warnings

Electric Shock:

There is a risk of electric shock if the Controller Base
Plate is opened.

Never use Controller Base Plate in or near water.
Keep Clear of all Liquids.

Cuts and Abrasions:

There is a risk of cuts and abrasions from tools,
attachments and edges of the MicroCNC machines
and the Controller Base Plate.

Take care when handling and during operation.

Crushed/trapped fingers:

There is a risk of trapping fingers and hands during
operation.

Ensure hands and fingers are kept clear of moving
parts during operation.

Eye Protection:
Eye protection should be worn during operation.

If power is cut to either the stepper motors (via IEC
Power Switch), or the DC Motor (via DC Motor On/
Off Switch) the software program will continue
to run and damage to the machine or work piece
could occur. For example: if power to the DC motor
is turned off during a milling operation the cutting
tool will stop cutting, this could cause the tool to
snap or the work to be damaged. Extreme Caution
Should be Taken Before Power is Restored.

Danger
Electric shock
risk
/A\CAUTION
Mechanical
‘ hazard.

Parts have sharp
edges.
Avoid contact.

Warning

Mind your hands

Eye protection
must be worn
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Before You Start

These instructions provide a step by step guide to
assembling the Micro CNC Machines from prebuilt
Modules, Micro CNC System Controller, and
Accessory Packs.

The four Micro CNC Machine are:

2 axis Micro CNC Lathe 3 ?X'is Micro QNC
(CN2668) Milling Machine

(CN4234)

Please Note: Matrix Supply four different Micro
CNC Machine Kits, these are shown below. Each
‘Kit" is made from a number of specific Modules
& Accessories. Please refer to the Assembly
Instructions for your ‘Kit" as different kits do not
include all the items listed below.

b ‘ ot

4 axis Micro CNC Complete Micro CNC set

Milling Machine (CN3885)
(CN8285)

The 4 Micro CNC Machines are assembled from different combinations of the following modules:

Lathe Module Vertical Mill Module

The Micro CNC Machines are assembled onto
the Micro CNC System Controller and Base Plate
(CN4079) shown below:

Cross Slide Module 4-Axis Extended Bed
Module
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Assembly Notes:

Matrix Micro CNC Kits & Machines
Modules

The Micro CNC System Controller and Base Plate
comes pre-fitted with a large retaining bar and
two small retaining bars as shown below. These
are pre-positioned to attach the machine module
conveniently towards the rear of the platform. These

can be repositioned anywhere on the platform
by loosening the screws slightly and sliding the
retaining bars form the ends of the platform and
repositioning as required.

Small retaining rods

Large retaining rod

Inserting Connection Pieces into
Module T-slots

To attach the Lathe module to the Cross Slide module
you will need to inset a Connection Piece, from the
accessory pack, into the T-slots in the module bases.
Note: the Connection Piece is ‘Keyed'’as shown opposite.
When inserting a Connection Piece it is important to
ensure the‘Key'is in the right orientation.

Use the ‘Allen Key’ screw driver, shown below, to tighten
/ slacken connection pieces.

When the ‘Key'is positioned into a T-slot the Connection Piece
can only be inserted upto the end of the module.

When the ‘Key'is positioned to the outside the T-slot the
Connection Piece can be positioned anywhere along the
modaule.




2 axis Micro CNC Lathe (CN2668)
Assembly

Parts required:

Micro CNC System Cross Slide Module Lathe Module Accessory Pack (Lathe)
Controller and Base Plate
(CN4079)

Step 1 - Attach Cross Slide Module to
Base Plate

Remove one of the screws from the long retaining
bar attached to the platform, loosen the other screw
to allow the long retaining bar to be lifted.

Loosen

Remove

Slide the Cross Slide module onto the long retaining
bar. Position the Cross Slide module centrally on the
platform.

Tighten both screws to hold the Cross Slide module
securely in place.

Tighten
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Place Lathe module behind the Cross Slide Module
at the rear of the platform and position it so that you
can insert a connection piece into the T-slots. The

Cross slide module

Connection Piece should be fully inserted into the  Connection
Cross Slide module with the‘’Key’as shown opposite. plece
Allen Key Screwdriver Lathe module

Holding the Connection Piece in place with the
Allan Key Driver carefully slide the Lathe module
along the Cross Slide module until the Tailstock is
aligned with the edge of Cross Slide module stepper
motor as shown opposite.

Insert a second Connection Piece into the T-slots at
the other end of the Cross Slide and Lathe modules;
again ensure the ‘Key’ of the Connection Piece is
inserted into the T-slot of the Cross Slide module.
Tighten both Connection Pieces.

Insert the small retaining bars into either side of the
Lathe module and tighten screws

Align Tailstock with Stepper Motor

Cross slide
module

Small retaining bars

Insert the Live Centre, found in the accessory pack,
into the Tail Stock of the Lathe Module.

Assemble the Tool post using the M4x70 socket
head screw and a slot nut from the accessory pack.
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Slide the assembled tool post into an appropriate
slotin the bed of the Cross Slide module and tighten
the central screw.

Assembled Micro CNC Lathe & Controller Base Plate

Before you can use the lathe the cutting tool will
need to be centred to the rotational axis of the work
piece. This is achieved by placing a centring bit into
the head stock of the lathe using the 3.5 mm collet
(this does not have grooves at the end) and aligning
the cutting tool with the bit.

Remove the 3 Jaw Chuck by placing the small bar
in the hole at the rear of the motor, hold this tightly
and turn the chuck anticlockwise to remove.

Place the centring bit and a 3.5mm collet into the
headstock and secure with the collet holder as
shown opposite.
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Loosen the screws in the tool holder and place in the
cutting bit, use the small brass shims (1mm, 0.4mm,
and 0.1mm) to adjust the height of the bit. The bit
needs to be in line with the centring bit.

Secure the cutting tool into the tool holder by
tightening the tool post screws.

The Chuck can be tightened and slackened using
the two small rods. Locate a rod in the holes and
move anticlockwise to loosen and clockwise to
tighten the jaws onto a work piece.

Depending on the size of the work piece you wish to
turn you may need to adjust the spacing between
the tailstock and the headstock.

This can be achieved by loosening the Connection
Piece between the lathe bed and the tailstock, and
the Stabilising Plate screws.

The tailstock is then free to slide towards or away
from the headstock. Once in postion retighten the
Connection Piece and the Stabilising Plate screws.
Any final adjustment can be made by roting the Jog
wheel of the tailstock to secure the workpiece.

Tailstock free to move
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3 axis Micro CNC Milling Machine
(CN4234) Assembly

Parts required:

(1
3 axis Micro CNC Milling Cross Slide Module Vertical Mill Module Accessory Pack (Mill)
Machine (CN4234)
Assembly

Step 1 - Attach Cross Slide Module to
Base Plate Loosen
Remove one of the screws from the long retaining

bar attached to the platform, loosen the other screw
to allow the long retaining bar to be lifted.

Remove

Slide the Cross Slide module onto the long retaining
bar. Position the Cross Slide module centrally on the
platform.

Tighten both screws to hold the Cross Slide module
securely in place.

Tighten
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The Vertical Mill module is packed in two parts and
requires assembling prior to attaching to the Base

Plate. Three parts are required for the assembly:
1. Tool Post & Motor Assembly

2. Short Machine Bed

3. Clamping Plate

Clamping Plate as
Shipped

Place the Clamping Plate into the screw slots of the
Short Machine Bed as shown opposite.

Slide the Tool Post & Motor Assembly onto the Short
machine bed ensuring the three clamping plates
locate into the T-slots of the Tool Post.

The Short Machine Bed should be positioned
underneath the Motor.

Carefully place the assembly onto a flat surface.
First tighten the two screws located on the inner
face of the Short Machine Bed, you will need to
insert the screwdriver into the short machine bed as
shown opposite.

Next tighten the four screws located on either side
of the Tool Post.

11

Tool Post & Motor
Assembly

A\

h
&
Short Machine
Bed
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Vertical mill module

Place the Vertical Mill module behind the Cross Slide
Module at the rear of the platform and position it
centrally along the carriage

Centre between carriage

Cross slide module

Using the Allen Key’Screwdriver, insert a connection
pieces into the T-slots between the Vertical Mill
module and the Cross Slide module, (stepper motor
end shown opposite).

The Connection Piece should be fully inserted into
the Cross Slide module with the ‘Key’ going into the = ,
Vertical Mill Module, see page 3 for ‘Key’ insertion Vertical mill module Allen Key Screwdriver
details.

Insert connection pieces into the T-slots between
the Vertical Mill module and the Cross Slide module.
The Connection Piece should be fully inserted into
the Cross Slide module with the ‘Key’ as shown
opposite.

Tighten the Connection Pieces.

Insert the small retaining bars into either side of the
Lathe module and tighten screws

Small retaining bars
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Assemble the Vice by loosely attaching 4 Slot nuts
to the vice using four M4x6 screws, screws and slot
nut are included in the accessory pack

Slide the assembled Vice into the slots in the bed
of the Cross Slide module and tighten the central
screw.

Grooves

=

1/8" Collet (Has Grooves)

13

To attach a cutting bit to the Motor Assembly use
the 1/8th Inch collet (this has groves on the end)

Place the collet into the motor assembly and secur
in place using the collet holder; do not tighten

Insert the cutting bit into the collet and tighten the
collet holder until the cutting bit is held in place

To secure the cutting bit into the motor assembly
use the small bar to hold the motor shaft steady
while the collet holder is tightend with the spanner.
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Assembled 3 axis Micro CNC Milling Machine & Controller Base Plate

Before using the 3 axis Micro CNC Milling Machine it
may be necessary to adjust the height of the cutting
tool this can be achieved manually or by using the
control software (software use is covered in the free
curriculum).

To manually adjust the cutting tool height two
methods are employed depending on whether
large or small adjustments are required.

Loosen, but do not remove, the four screws located
on either side of the tool post.

14

For small adjustment the cutting tool can be
repositioned by turning the jog handle attached to
the Z axis stepper motor.

For large adjustment it will be necessary to move
the cutting tool up or down as follows.

Loosen screws
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Loosen, but do not remove the Locknut Screw

Hold the Cutting Tool Head securely while loosening
the Connection Piece located between the Tool Post
and the Small Cross Slide/Motor Assembly.

Move the Cutting Tool Head up or down as required
and then tighten all fixings.

15
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4 axis Micro CNC Milling Machine
(CN8285) Assembly

Parts required:

o8 g

o

qEaly
Sl

L)/
7
3 axis Micro CNC Milling Cross Slide Module  Vertical Mill Module  4-Axis Extended Bed Accessory Pack (Mill)
Machine (CN4234) Module
Assembly

Step 1 - Attach Cross Slide Module to
Base Plate

Remove one of the screws from the long retaining
bar attached to the platform, loosen the other screw
to allow the long retaining bar to be lifted.

Loosen

Remove

Slide the Cross Slide module onto the long retaining
bar. Position the Cross Slide module centrally on the
platform.

Tighten both screws to hold the Cross Slide module
securely in place.
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The Vertical Mill module is packed in two parts and
requires assembling prior to attaching to the Base

Plate. Three parts are required for the assembly:
1. Tool Post & Motor Assembly

2. Short Machine Bed

3. Clamping Plate

Clamping Plate as
Shipped

Place the Clamping Plate into the screw slots of the
Short Machine Bed as shown opposite.

Slide the Tool Post & Motor Assembly onto the Short
machine bed ensuring the three clamping plates
locate into the T-slots of the Tool Post.

The Short Machine Bed Should be positioned
underneath the Motor.

Carefully place the assembly onto a flat surface.
First tighten the two screws located on the inner
face of the Short Machine Bed, you will need to
insert the screwdriver into the short machine bed as
shown opposite.

Next tighten the four screws located on either side
of the Tool Post.

17

Tool Post & Motor
Assembly

A\

h
&
Short Machine
Bed
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Vertical mill module

Place the Vertical Mill module behind the Cross Slide
Module at the rear of the platform and position it
centrally along the carriage

Centre between carriage

Cross slide module

Using theAllen Key’Screwdriver, insert a connection
pieces into the T-slots between the Vertical Mill
module and the Cross Slide module, (stepper motor
end shown opposite).

The Connection Piece should be fully inserted into
the Cross Slide module with the ‘Key’ going into the = =
Vertical Mill Module, see page 3 for ‘Key’ insertion Vertical mill module Allen Key Screwdriver
details.

Insert connection pieces into the T-slots between
the Vertical Mill module and the Cross Slide module.
The Connection Piece should be fully inserted into
the Cross Slide module with the ‘Key’ as shown
opposite.

Tighten the Connection Pieces.

Insert the small retaining bars into either side of the
Lathe module and tighten screws

Small retaining bars
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Before attaching the 4-Axis Extended Bed Module
you will need to reposition the Cutting Tool Head at
the top of the Tool Post as follows:

Loosen, but do not remove, the four screws located
on either side of the tool post.

Loosen, but do not remove the Locknut Screw

Hold the Cutting Tool Head securely while loosening
the Connection Piece located between the Tool Post
and the Small Cross Slide/Motor Assembly.

Move the Cutting Tool Head up or down as required
and then tighten all fixings.

19
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Move the Y-axis cross slide away from the tool post
by turning the jog handle anticlockwise to allow
sufficient room to insert the Extended Bed module.

The 4 Axis Extended Bed module is packed as
shown opposite. Prior to assembly you will need to
reposition the motor and tailstock.

Remove the four Stabilising Plate screws.

20

Remove screws

Loosen the Connection Piece located between the
bed and motor assembly.

Slide the motor assembly towards the end of the
bed and align the holes of the stabilising plate with
the holes in the bed.

Replace the Stabilising Plate screws and retighten
the Connection Piece.
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Loosen the Connection Piece located between the
bed and tailstock.

Slide the motor assembly towards the end of the
and align the holes of the stabilising plate with the
holes in the bed.

Replace the Stabilising Plate screws and retighten
the Connection Piece.

Slide the 4 Axis Extended Bed module into the slots
in the bed of the Cross Slide module and tighten the
four retaining screws.

Grooves

=

1/8" Collet (Has Grooves)

To attach a cutting bit to the Motor Assembly use
the 1/8th Inch collet (this has grooves on the end)

Place the collet into the motor assembly and secur
in place using the collet holder; do not tighten

Insert the cutting bit into the collet and tighten the
collet holder until the cutting bit is held in place

To secure the cutting bit into the motor assembly
use the small bar to hold the motor shaft steady
while the collet holder is tightend with the spanner
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Assembled 4 axis Micro CNC Milling Machine & Controller Base Plate

Step 7 - 4 Axis Vertical Mill Pre-use
Adjustments

Before using the 4 axis Micro CNC Milling Machine it
may be necessary to adjust the height of the cutting
tool to enable sufficient movement of the cutting
tool; it may also be necessary to adjust the length
of the extended bed to ensure a work piece is held
securely.

22

Adjusting the Cutting Tool Head
Position

To manually adjust the cutting tool height two
methods are employed depending on whether
large or small adjustments are required.

For small adjustment the cutting tool can be
repositioned by turning the jog handle attached to
the Z axis stepper motor.

For large adjustment it will be necessary to move
the cutting tool up or down as follows.
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Loosen, but do not remove, the four screws located
on either side of the tool post.

Loosen, but do not remove the Locknut Screw

Hold the Cutting Tool Head securely while loosening
the Connection Piece located between the Tool Post
and the Small Cross Slide/Motor Assembly.

Move the Cutting Tool Head up or down as required

and then tighten all fixings.

Remove screws

Both the motor and the tailstock can be adjusted to
allow workpieces of different sizes to be secured.

To reposition the motor and tailstock. remove
the four Stabilising Plate screws. And loosen the
Connection Pieces between the bed and motor,
or tailstock as required. Reposition to a suitable
location and replace the screws then tighten the
Connection Pieces.
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Adjusting the Length of the Extended
Bed

Both the motor and the tailstock can be adjusted to
allow workpieces of different sizes to be secured.
To reposition the motor and tailstock remove
the four Stabilising Plate screws and loosen the
Connection Pieces between the bed and motor,
or tailstock as required. Reposition to a suitable
location and replace the screws then tighten the
Connection Pieces.

24

Remove screws

To secure a workpiece into the 4 Jaw Chuck use the
2mm Allen key to adjust the position of each Jaw
individually, there are guide lines on the face of the
chuck to help centralise the workpiece.

A live centre can be fitted to the tailstock to secure
longer workpieces as required.
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Matrix MicroCNC —

The Matrix Micro CNC Systems offer a range of three
machines, Lathe, 3-Axis Milling Machine, and 4-Axis
Milling Machine. Each of the machines is operated
from the Controller and Base Plate (CN4079) shown
below:

Getting Started

The Controller Base Plate has a Linux based
control system at its core, and houses all electrical
connections required to connect to the three
machines, and for connection to a PC. The Controller
Base Plate also incorporates a range of safety
features, both software enabled and physical to
ensure safe operation within an educational setting.

The controller base plate provides a secure platform
for each of the three machines in the range and
the previous sections cover installation of these to
the platform. Once a machine is securely mounted

This section of the document provides information
on how to safely use the hardware and software; it
also demonstrates how to import your Numerical
Control (G-Code) files to the controller and how to
set up, and operate, your machines using the control
software provided.

electrical connections are made to the Platform
Inlet Face; the connection for the stepper motors
are dependent on the type of machine being used
and are covered in the next section.

25
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The DC motor connection is used to operate the
Headstock (Chuck) of the lathe, or the Cutting bit for
the milling machines. The motor is turned on using
the DC motor On/Off switch at the right hand end of
the inlet face; positioned to allow easy access while
the machines are running. The DC motor CANNOT
be operated unless the platformis connected toa PC
and the control software is running. In addition, the
DC motor is also connected to the Emergency Stop
button located on the opposite end of the platform,
right front during normal operation. In the event
of the emergency stop button being pressed the
restart procedure should be followed, see Page
XX.

The USB connection provides an interface to
the PC. The USB is used to internally power the
embedded Linux controller allowing program files
to be imported, and machine setting to be entered

without the motors being energised.

The IEC Power Inlet provides a switched, and
fused, connection to a 110 - 240V (50-60Hz) mains
supply. In addition, it is RECOMMENDED that the
mains connection is provided through an RCD (Not
Supplied). If manual adjustments to the stepper
motors need to be made, i.e. during tooling, or
origin, setup, the IEC switch can be turned Off, this
will remove power from the motors to allow the
adjustments to be made. Turning off the power
with this switch has no effect on the software, or any
programs running, see warning notes at the end of
the document. Note the stepper motors should not
be moved manually while energised.

Matrix MicroCNC machines provide two methods of
initiating and emergency stop. These are a‘Physical’
emergency stop button located on the right hand
end of the Controller Base Plate and a ‘Software’
emergency stop within the control software. The
software emergency stop will be covered later in
this document.

To disengage the Emergency Stop, twist the Red
cap clock wise.

The ‘physical’ Emergency Stop is activated by
Hitting/Pressing into the platform, once engaged
it will terminate power to the stepper motors and
the DC motor simultaneously. After pressing the
Emergency Stop button itis recommended that you
follow the restart procedure stated below.

Caution - Disengaging the Emergency Stop Will IMMEDIATELY Restore Power to Both Stepper and
DC Motors. If a cutting program is running it will need to be stopped. Cutting operations MUST BE

STOPPED before power is restored.

26
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The restart procedure below assumes that the ‘Physical’ emergency stop button was activated to prevent
injury to person(s) or to prevent damage to the machine/tool/part.
Restart Procedure

Isolate Controller Base Plate from mains electrical supply

Switch off the DC Motor Toggle Switch.

Switch off the IEC Power Switch.

Stop the cutting program in software. (Note: the ‘Physical’

emergency stop has no effect on the cutting tool program,

this will continue running until stopped in software.

5. Manually operate stepper motor jog wheels to move
cutting tools clear of the work piece/machinery.

6. Remove and replace any damaged cutting tools / stock
from the machine.

7. Disengage the Physical’emergency stop button

After following the above procedure -cutting
operations can be resumed after ensuring the
Hazardous condition that initiated the emergency
stop has been removed.

N =

Connect the Cross Slide Module Motor Leads to
the ‘X" and 'Z’ sockets on the platform, connect the
DC Motor Jack Plug to the DC Motor socket on the
platform as shown below.

DC motor

Z-axis motor

X-axis motor

Connections
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Connect the Cross Slide Module Motor Leads to the
‘X’and 'Y’ sockets on the platform

Connect the Mill Module Z-Axis Motor Leads to the
'Z' socket on the platform, connect the DC Motor
Jack Plug to the DC Motor socket on the platform as
shown below.

28

X-axis motor

Y-axis motor

Cross slide module

DC motor

Z-axis motor

STEPPI  ‘TORS

Connections
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Connect the Cross Slide Module Motor Leads to the
‘X’and 'Y’ sockets on the platform

Connect the Mill Module Z-Axis Motor Leads to the
‘Z' socket on the platform, connect the DC Motor
Jack Plug to the DC Motor socket on the platform as
shown over the page below.

Connect the A-Axis of the Extended Bed Module
to the ‘A’ Socket on the platform as shown over the

page.

A-axis motor

A-axis (4t rotary)

29

Y-axis motor

X-axis motor

Cross slide module

Z-axis motor

Mill module

Connections

DC motor
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Connect a PCto the Controller Base Plate viathe USB  You do not need to power the Controller Base Plate
connection port; after afew seconds the MATRIXCNC as the controller hardware is internally powered
Windows Directory shoud open as shown below. from the PC.

NOTE:
If you receive a warning about Potential Security Risks, as shown below press‘y’to update the cached

key. You may need to disconnect and then reconnect the PC/Laptop after the update.

System Volume Information
Windows

— Local Disk (W:)

= WINRETOOLS (Z)

MATRIXCNC Windows Directory

If using the software on a computer for the first time it is advisable to install the drivers prior to launcing

the control programs.
Use the following instruction to install the drivers:

New it
. x| CAWINDOWS)\system32\cmd.exe
Pin to Quick Detete New [
aaaaaa - folder
Clipboard Organize New
= > ThisPC > MATRIXCNC (G) Search MATRIXCNC (G) o ::/ PP ///// H // ’
¥ MATRIXCNC (G B
© B teme 13items Plea_‘e he patlent ..
Trash-1000 Trash- 1000 ng configuration 49 xis
Doe D mRNING — POTENTIAL SECURITY BRERCH'
Line Line he server's host key does not match the one PulIY has
ached in the pegistry. This means that either the
Mac M eruver admin rator has changed t]\e host key or you
5
pen ~ o be the server

he new wpsa2 key fingerprint 1'-:

2048 88:3h:bZ:%a:h

the new key,

cache and continue connecting.

n cunnectlng but without updating

84:3a:57:ab:5a:3a

afe choice.

date cached key?

the connection completely, press
[Return to cancel. Pressing Return is the ONLY guaranteed

Security Warning - Select‘y’and continue

H Ho sh: M:
Connect Platform to PC, wait a few seconds for the B
MATRIXCNC Drive to open.
- This PC MATRIXCNC (G:)
~ o MATRIXCNC (G) # [0 Name 13 items
Trash-1000 Trash-1000
Dec Doc
Linw Lint
Mac Mac
System
e System Volume Information \
‘Windows
f
\ 2AXIS L ATHE bat
Launch_3AXIS_MILLbat
Launch_4AXIS_MILL.bat
Launch_File_Transfer.bat
Select and open the ‘Windows' folder... > — o
cccccc o fold - st Invert selecti
- This PC MATRIXCNC (G:)
= MATRIXCNC (G:) ~ O Name Windows
Trash-1000 Trash-1000 File folder
Dec Doc
Lint Linux
Mac Mac
System System
System Velume Information x_tl-fystemVolumednformation— +~ _
I Windows I
Windows I [ girectory N 1
= Local Disk () + inf— — — — — A
e Lau 1
. : Windows l} 1
A 1
Fic L directory !
\
-l autorunind )




Select and open the ‘Drivers’folder...

Select and open either ‘microCNC_32bit_installer.
exe’or'microCNC_64bit_installer.exe’depending on
your computers operating system.

| Welcome to the BeagleBone
Driver Installer!

* This wizard will install drivers to help you connect to your
- BeagleBone.

%

To continue, click Mext.

< Back Nest = Cancel

Installing the scftware for your BeagleBone. ..

(2

Please wait while the drivers install. This may take some time to complete.

< Back Next = Cancel

bome | shre Vi °
»* Lé J :;Cut s B x !ﬁ T Newitem + \ﬂ

Copy path Flessyaccess - cai

 Open+  Fsetectan

Select none
Pinto Quick Copy Faste Move G Delete R . Propeti
Mcess P B paste shortat 't for e T folder 1RSI G tistoy | 2B invert selection
Clipboard Organize New Open Select
« v |5 ThisPC > MATRIXCNC (G) > Windows > v| o] | searchWindows »
~ - .
= MATRIXCNG (G:) 0 Name Date modified Drivers
Trash-1000 Drivers File folder
Doc |\ MACHINES by
Linue ~
A
Mac
\ [ gk
System N '
System Volume Information \ ' D \
Windows [ 1
= Local Disk (W) A 1
— WINRETOOLS (Z:) \a 1
i 1
@ Libraries N

%] Documents

= Pictures

home | st view | Nomsse )

= & Cut iE] x !ﬁ T New item ~ @ [E open ~  Fselectall
= = Copy patn « £ oy access - Eait Seiect none
Pinto Quick Copy  Paste Move Copy Delete Rename  New Properties
Lo ] Paste shorteut =Ty |t e 2 (@ History | S invert selection
Clipboard Organize New Open Select
« ~ 4[> ThisPC » MATRIXCNC (G) > Windows > Drivers v | @] | Search Drivers »
= MATRIXCNC (G) O Name Date medified microCNC_64bit_installer.exe
Trash-1000 cpcacM Application
Doc FIDI
Linue Original
Mac RNDIS %
System ff beagle.ico
dpinstaml
System Volume Information L dpinst.
8] in-hand.bmp Date modified:  25/07/201712:35
Windows R o e = =

. % microCNC 32bit_installerece |
1% microCNC bt insallerese
= == N

N

Size:

— Local Disk (W:)
= WINRETOOLS (Z)

Date created:

=~ nuilapilty:

30710/2017 11:58
Available offline

K= - . ——
an\bvaNEs \ o P < o
% Documents \ o . o

» Musc . *§ microCMC_32bit_installer.exe

& Pictures \

1
1
« 1 Z1%% microCNC_64bit_installer.exe
1
1

In the‘User Account Window’selectYes’when asked
“Do you want to allow this app to make changes to
your device?”

In the Installer Window, shown opposite, select
‘Next >’

Whenthedriverbeginstoinstalla’'Windows Security’
window may launch; select ‘Install’ to continue the
installation

EZ] Windows Security X

Would you like to install this device software?

Name: Linux Developer Community Ports (COM & L...
S Publisher: Matrix Technology Solutions Limited

Always trust software from "Matrix Technology
Solutions Limited",

[ \nstall{:gl Don't Install |

() You should only install driver software from publishers you trust. How can | decide which device
software is safe to install?
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Once the insallation completed, click the ‘Finish’ [ecgirons orverinetaier
button to return to the MATRXCNC Drive.

Batch Files

Within the MATRIXCNC directory you have access
to four batch files (.bat), these are used to operate
the three different machine types, and to facilitate

Batch files
Launch_2AXIS_LATHE.bat

' Drivers installation complete

¥  device came with your software, you can now connect it to this
. computer. i your device came with instructions, pleases read them
' first.

S | ~ Linux Developer Commu... Device Updated
. - | % BeagleBone COM Driver... Ready to use
_ | »/ BeagleBone COM Driver... Ready to use W

The drivers were successfully installed on this computer! I a

Driver Name Status 3

< Back Cancel

Function

Sets up control software for Turning
operations. Cross Slide Module has
X-Axis and Z-Axis

file transfers from a Windows based system to the
controller software; the table below describes the
function of each batch file:

Use with...
Lathe Kit - CN2668

Complete Set - CN3885 (Lathe
Config.)

Launch_3AXIS_MILL.bat

Sets up control software for 3-Axis
Milling operations.  Cross Slide
Module has X-Axis and Y-Axis,
Vertical Mill Module has Z-axis

3-Axis Milling Machine Kit - CN4234

Complete Set — CN3885
(3-Axis Mill Config.)

Launch_4AXIS_MILL.bat

Sets up control software for 4-Axis
Milling operations.  Cross Slide
Module has X-Axis and Y-Axis,
Vertical Mill Module has Z-axis
Extended Bed Module Has A-Axis
(rotary)

4-Axis Milling Machine Kit — CN8285

Complete Set - CN3885
(4-Axis Mill Config.)

Launch_File_Transfer.bat

Used toimport and export Numerical
Control (G-Code) between Windows
and Linux Directories.

All kits in conjunction with control
software

The batch file selected will depend on the type of machine attached to the platform, or whether a file need
to be transferred between systems. File transfer will be covered in a separate section.

32
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Application Tools

= MATRIXCNC (G)
Home  Share  Wiew Manage

- o X
e
[} New item + | Open ~ Select all
% " B
{7 asy access - - [Jreat Select none
e
- l@tistoy T invert selection
v o Search MATRIXCNC (G: »

Date modified

Launch_4AXIS_MILLbat
Windows Batch File

Date modified:

Size:
Date creste
Availabili

3items 1 item selected 76 bytes

X =]
. a2 Copy patn *
Copy Move Copy Delete Rename  New
tor tor - folder
Clipboard Organize
« © A > ThisPC > MATRIXCNC ()
- J2GBUSE (F) A O Name -
— MATRIXCNC (G) Trash-1000
Trash-1000 Dec
Doc Linue
Linue Mac
Mac System
System Volume Information
System ¥
Windows
System Volume Information
] directory
Windows 1] autoruniin
== Local Disk (W:) Launch_2AXIS LATHE bat
— WINRETOOLS (Z) Launch 3AXIS_MILLbat
Launch 4AXIS MILLbat
Libraries = e N
Launch_File_Transfer bat
| Documents
b Music
= Pictures
B videos ¥

After selecting and opening an appropriate batch
fileyou will see awindow similar to the one opposite.
(this example shows the ‘Launch_4AXIS_MILL.bat’)

Note: The first time you open a file you may be
asked to ‘Store key in cache? (y/n)’ type ‘y’ and
press enter

After a few seconds, a ‘Splash’ screens will open
and the MicroCNC control software should launch,
after a few more seconds the control program will
launch and a window similar to the one below
will open, (this example shows the 4-Axis Milling
configuration):

Splash screens:

Bl CAWINDOWS\system32\cmd.exe - O X

., without

Return to abandon the

Y |

X %xerd-BuildingBrick,Uni-frae54-1.ng[ - AXIS with MachineKit 0.1 on UNI-FRAES-4
File Machine View User Help

QR oI dpDiufi[n e#=zNXIY[EE B

Manual Control [F3] | Mpl [F5] | Previw | DRO |

Ais: @ X C¥

A
- | +|[continuous =]
Home Axis | Touch off

Feed Override:

100%[0_|_ [
126 mm/min || [
Jog Speed: 126 deg/min | _| [
Max Velocity: 3000 mm/min [ | |

. (Building Brick project - Uni-Fraes4 - material: foam 26x26x50 mm, tool: end mill 1.6 mm.) &
2: (zero point: Y-turning axis, X-rigth end of the material, Z-material surface.) B

2. (setting zero point: rotate A-axis until surface is even, move the tip of the endnill to t
he)

4: (right end of the foam block, to the middle on Y-axis and)
S: (then move down on the Z-axis until you almost touch the material.)
G (now home all axis)
¢+ (turn down the feed override to 40%, then start, after a while you can turn feed override
back to 100%)

on [ne tool

Jog Speed:

)=

Position: Relative Actual

St com




The programs for the three different machines are essentially the same; however, the available axis, and the
preview screen will be different dependent on the program that was opened. The example below shows
the 4-Axis Machine program.

Machine Power ON/
OFF Toggle button Run, Pause, & Stop

Software Emergency Stop & erc3-BuildingBrick_Uni-fraesd-1.ngc - AXIS with W¥chineKit 0.1 on UNI-FRAES-4 - [m] x

ON/OFF Toggle button \ ble

achine View User Help

QLIS Ml =z NXIYPHE »
Axis Select Radio Buttons Manyal control [F3) 1 MDI [75] e | 0RO
Axis:

Stepper Motor Control — ] =
Buttons _|_I

Home Axis Button —

Preview Screen /

Feed Override: 100%
Jog Speed: 126 mm/min

Jog Speed: 126 deg/min
Max Velocity: 3000 mm/min

(setting zero point: rotate A-axis until surface is even, move the tip of the endmill to the)
(right end of the foam block, to the middle on Y-axis and)

Information Screen (then move down on the Z-axis until you almost touch the material.)
\ (now home all axis)

g21
961
q0 z2
g0 a0

ESTOP No tool Position: Relative Actual

- Software Emergency Stop ON/OFF Toggle - Stepper Motor Control Buttons
button

« Home Axis Button
«  Machine Power ON/OFF Toggle button

«  Run, Pause, & Stop Buttons - Preview Screen

- Information Screen
« Axis Select Radio Buttons



Basic Operations

When a control program is launched its default state
is to have the software ‘Emergency Stop’ engaged,
and the ‘Machine Power’ turned off; in this state the
axes selection and motor control buttons are‘greyed
out’and are not selectable, as shown opposite.

To operate the stepper motors, disengage the
software’Emergency Stop; thenturn onthe’Machine
Power’; the axes selection radio buttons and the
stepper motor controls will then be enabled.

To manually operate the stepper motors, select the
axis to be moved using the radio buttons and use
the '+’ or -" buttons to move the carriage along the
selected axis; note the direction of movement will
depend on which machine program is being used,
see following sections.

You can control the stepper motors with continuous
movement, or stepped increments, by changing the
selection in the box next to the ‘+"and’-’ buttons, as
shown opposite.

With ‘Continuous’ selected the motors will move
continuously while the ‘+" or -' buttons are being
pressed.

With one of the increment steps selected (0.1000,
0.0100, 0.0010, or 0.0001) the motor will move
incrementally by the selected distance for each
press of a‘+’ or’-" button.

To operate the DC Motor the platform needs to
be connected to a computer and the appropriate
control program open; if the software is not open the

35

Eile Machine Wiew WUser Help

CIIEEIE

Manual Control [F3] ]MDI [F5] ]
Aais:

B
|

File Machine View WUser Help

CIEYIEE Y.

Manual Control [F3] ] MDI [F5] ]
Axis:

| 2l 5]
|

Eile Machine Miew User Help

QR bDi

Manual Control [F3] I MDI [F5] ]
Ais: = X o Z

_—ILIICOntinuous hd

Home Axis | Touch Off |

Manual Contral [F3] ]MDI IF5] |
Axis: X v 7

|+ [T
Continuous ﬂl

0.1000

0.0010 !

0.0001

Home

DC Motor cannot be activated. Unlike the stepper
motors the DC motor is not controlled through the
program but via the toggle switch on the control
face of the platform; the motor should be running
with the switch in the upper position, and off when
the switch is in the lower position.

Copyright © 2017 Matrix TSL



Step 4 of the 2 axis Micro CNC Lathe (CN2668)
Assembly instructions give details of how to
‘physically’ set the centre zero for the lathe cutting
bit. In addition, this point may need to be set as the
zero or ‘Home' position in the control software. The
following instructions provide information on how
to set the control software ‘'Home’ position after

Select the axis to be moved using the Axis Radio
Buttons and set the movement to continuous, or
one of the incremental steps (0.1 to 0.0001), use the
‘+"and - buttons to move the axis to the required
position. Refer to diagrams below for relevant
direction of movement.

Use continuous for large movements, then fine tune
the position with incremental steps (or manually).

Once the Cutting tool is in the correct zero or home
position click the’'Home Axis’button the coordinates
in the preview area will be set to zero (0.000) with
the gy symbol displayed next to the homed axis.

X Drehteil mit Fase.nge - AXIS with Machinekit 0.1 on UNI-DREH - o x
File Machine View User Help

Qeeg reulEiu+=%

Manual Control F3] | Mpi (s] | Preview | DRO |

A X Z
_-| +[continuous |
Home Axis | _Touch off

Feed Override:

Jog Speed;

Max Velocity:
T

100 %]
126 mm/min
3000 mmimin

-

3 g7 (activate dianeter mode)
2 103 510000
5. g0 x20

g0zl
7090 x11.8
5 gl z-20 1100

q1 312 z-21 7!
o [No teol |Position: Relative Actual

The image opposite shows the direction of
movement for the Lathe Axes corresponding to the
‘+"and -’ Stepper Motor Control buttons.

NOTE: to avoid ‘Crashing’ the carriage into the
end of the machine bed change the movement
setting from continuousto one oftheincremental
settings such as ‘0.1000’ as the ‘Zero’ position is
approached.

aligning the cutting tool with the centring bit.
Note: alignment of the tool with the centring bit can
be done by manual adjustment of the lathe with the
Controller Base Plate power turned off, or using the
control software to move the lathe, Controller Base
Plate power would need to be on.

Manual Cantrol [F3] ] MDI [F5]
Axis: v X (£

_-|l”C0ntinu0usﬂ

Home:\xis Touch Off |

|Send active axis horme [Home]l

Manual Control [F3] ] MDI [F5]

Axis: X v £

_—|L||Continuousﬂ

Preview IDRo 1

Rad:

Preview IDRo ]

$Rad:  -0.000
Dia: -0.000
& 0.000

Homed Coordinates

2.702
Dia: 5.404
Z: 2,831

Un-Homed Coordinates




Step 5 of the 3 axis Micro CNC Milling Machine
(CN4234) Assembly instructions (also Step 6 of the 4
axis Micro CNC Milling Machine (CN4234) Assembly
Instruction) give details of how to ‘physically’ set
the home or zero position of the mill cutting bit.
In addition, this position may need to be set as the
zero or 'Home' position in the control software. The
following instructions provide information on how
to set the control software ‘Home’ position after
aligning the cutting tool with Home or Zero of the
workpiece.

Select the axis to be moved using the Axis Radio
Buttons and set the movement to continuous, or
one of the incremental steps (0.1 to 0.0001), use the
‘+"and -’ buttons to move the axis to the required
position. Refer to diagrams below for relevant
direction of movement.

Use continuous for large movements, then fine tune
the position with incremental steps (or manually).

Once the Cutting Bit is in the correct zero or home
position click the 'Home Axis’ button for each axis X,
Y, & Z for the 3-Axis Mill, (X, Y, Z, & A for the 4_axis
Mill), the coordinates in the preview area will be set
to zero (0.000) with the gy symbol displayed next to
the homed axis.

NOTE: to avoid ‘Crashing’ the carriage into the
end of the machine bed change the movement
setting from continuoustoone oftheincremental
settings such as ‘0.1000’ as the ‘Zero’ position is
approached

X exerc3-BuildingBrick_Uni-fraesd-1.nge - AXIS with MachineKit 0.1 on UNI-FRAES-4 - o x
Eile Machine View User Help

Qe e bpufEin e=2RXV[PE b

Manual Control (F3] | MDI [FS] | Preview | DRo |

Adst X OV Z

oA
- |+ [[continuous |
Home Axis Touch Off

Feed Override:

100%[1_|_ [
Jog Speed: 126 mm/min
Jog Speed: 126 deg/min
Max Velocity: 3000 mm/min [ |

1. (Building Brick project - Uni-Fraesd - material: foan 2626x50 nn, tool: end mill 1.6 nn.)

2: (zero point: Y-turning axis, X-rigth end of the material, Z-material surface. i

. (setting zero point: rotate A-axis until surface is even, move the tip of the endmill to t
he)

4: (right end of the foam block, to the middle on Y-axis and)
S: (then move down on the Z-axis until you almost touch the material.}
(now home all axis)
7: (turn down the feed owerride to 40%, then start, after a while you can turn feed override
back to 100%)

Jon [No tool

|Position: Relative Actual

Note: alignment of the cutting bit with the home
or zero of the workpiece can be done by manual
adjustment of the mill axes with the Controller Base
Plate power turned off, or using the control software
to move the mill axes, Controller Base Plate power
would need to be on.

Manual Contral [F3] I MDI [FE
Axis: o X Y —Z

_—Ii"t:cmtinuuusj
3-axis mill

Manual Cantrol [F3] ] MDI [FE
Axisy o X Y -z

A
_—Il"t:untinuousﬂ

4-axis mill

Home:\xis Touch Off |

|Send active axis horme [Home]l

Preview IDRO ]

¢Rad:
Dia:

¢ Z:

Homed Coordinates

Preview IDRO 1
Rad: 2.702
5.404

-0.000
-0.000
0.000

Dia:
Z: 2.831

Un-Homed Coordinates



Milling Machines Axis Movement
Directions

The images below shows the direction of movement for the Milling Machine Axes corresponding to the
‘+"and "-* Stepper Motor Control buttons. The X, Y, & Z Axes are the same for both the 3-Axis and 4-Axis
machines, with the addition of a 4th Rotary axis (A-Axis )on the 4-Axis Machine

A-axis

File Transfers

In the MATRIXCNC Windows Directory there is a
Batch file (Launch_File_Transfer.bat), this is used to
facilitate the transfer of Numerical Control files (*.nc
or *.ngc), your ‘G-Code’ files, between a Windows
based PC and the Linux system within the Controller
Base Plate. To Launch the file transfer program,
select and open the Launch_File_Transfer.bat batch
file and open as shown opposite:

38

- =] Application Tools  MATRIXCNG ()
ome  shae  view Manage )

<« “ 4w > THisPC > MATRIXCNC (E)

& Downloads
B Music

i, Local Disk (C)

= 328 USB (0)

= MATRIXCNC (E)
Trash-1000
Doc

Mac

System

System Volume Information
Windows

= 326B USB (0:)
= MATRIXCNC (E)

e Network

3items  1item selected 65 bytes

~ © | Search MATRIXCNC (E) »

Launch_File_Transfer
Windouws Batch File

System
System Volume Information
Windons
7] directory
&l un
=

ch_2AXIS_LATHE
[=] Launch_3AXIS_MILL
[T Launch_4AXIS_MILL
[Z] Launch_File_Transfer N
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N . . g . .
After a few second the ‘"WinSCP Login” window will | Bwrsceiean - x
New Site Session
open. T —— s
. ' . ,
Click the ‘Login’ button, after a few seconds a
Host name: Port number:
window similar to the one below will open. [2372 L=
User name: password:
[machineise [[seseaseasansance ]
Edit Advanced... |+
. .
Note: If a connection cannot be established,
. .
ensure the correct drivers have been installed,
1 H H 4
see‘Installing Drivers.
Toos v Manage Logml' Close Help
& C:\ - machinekit@1392.168.7.2 - WinSCP - O X
Local Mark Files Commands Session Options Remote Help
[ £2 3 synchronize [l oF [ @ [ 50 Queue v - Transfer Settings Default Y-
[ machinekit@192.168.7.2 [ New Session
‘i, C Local Disk =] NE e ne_files =] ™ & ByFindFiles T = -
£l Upload K = Lig Properties | £ [ £ Lo
o\ /home/machinekit/nc_files
MName act Size Type Changed Name a:t Size Changed Rights COwner
SRecycle.Bin File folder 11/2017 08:20:27 . 16/03/2015 01:253:47 TWXT=XT-3 machi...
Automatics File folder 06/07/2017 12:34:01 examples 26/08/2017 14:40:42 PWXT-XT-X machi...
Debug_lmport File folder 25/01/2016 10:32:20 share 02/04/2015 15:04:52 TWXT XT3 machi...
Dev File folder 02/11/2017 12:09:25
Documents and Setti... File folder 10/07/2015 13:21:38
dotnet33 File folder 24/12/2015 12:03:29
Intel File folder 03/08/2015 11:49:30
Perflogs File folder 30/10/2015 07:24:24
PHP File folder 15/03/2017 11:18:34
Program Files File folder 06/11/2017 08:36:26
Program Files (x26) File folder 07/06/2017 13:16:32
ProgramData File folder 30
Recovery File folder 2:01:08
RelDbg File folder 04/03/2016 1507
SmartMonitor File folder 15/03/2017 11:23:10
SOLIDWORKS Data File folder 06/06/2017 14:50:47
System Volume Infor... File folder 30/10/2017 13:33:28
temp File folder 0171172017 10:22:70
tmp File folder 16/05/2017 17:19:34
isers: File folder 02/11/2017 08:18:45
Windows File folder 06/11/2017 08:36:14
D bootmgr 386 KiB  File
[ eooTxT 1B File of W
0B of 3,697 MiB in 0 of 26 0Bof0BinDof2
5 SFIP-3 1:15:27
/ N\
‘Windows' drive ‘Linux’ directory

Navigating the ‘Windows’ and Linux
Drives

Drives can be selected from the drop down menu;
for example, to select a USB drive click on the down
arrow and select the required drive, as shown
opposite:

After selecting a drive navigate through folders
by double ‘left clicking’ to open folders and using
the + .. button to navigate back up to through the
Parent Directories to the Root Directory.

39

& C - machinekit®192,168.7.2 - Win5CP

Local Mark Files Commands Session Options Remote Help
[ % @Synchronize = @ [ {5} r_2| @Queue - T
[ machinekit@192.168.7.2 [ Mew Session

i, C: Local Disk FlEm N2 % ie

E fsﬂy:tocuments Iﬁl Praperties ﬁ &
esktop
¢ Local Disk

m Size  Type Chang
s E: MATRIXCNC File folder 02/11/%
Automatics File folder 06/07/:
Debug_lmport File folder 25/01/:
Dev File folder 02,114
Documents and Setti... File folder 10/07/%
dotnet33 File folder 24/12/:
Intel File folder 03/08/:
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Alternatively, ‘Right Click’ the drive ribbon and
select ‘Open Directory/Bookmark..., or double ‘Left
Click’ the drive ribbon, to open a standard Windows
directory navigation window, as shown opposite:

Directory ribbon

/

Locat) k) i oo Sision] Opions] Rt Hal
mE& L=}
2 machinetGI216272 G New Sesson
068U @@ D[ -

‘Right click’

‘Left click’

The simplest way to transfer files is to ‘drag & drop’ them from one directory/folder to another; this
automatically creates a copy of the file in the new location. The example below shows how to copy a file
located on the PC desktop to the default file location on the Linux drive

‘Left click’and ‘hold’ the file to be copied, then ‘drag
and drop’ the file in the new location.

A copy of the file is now located in the default folder
‘/lhome/machinekit/nc_files’ of the Linux Drive.

The file can now be opened by the machine control
software as shown opposite:

Local Mark Files Commands Session Options Remc
B &2 53 Synchronize | W F [ @[3 @
[ machinekit®192.168.7.2 5 New Session
Desktop @ EEOf
25 Upload [ | [ Edit 3 4 [ Properties | B [&
C:\Users\lanF\Desktop

Name Ext Size

.

=] MicroCNC Assembly Instructions - M.
44418
65,5608

2028

| Matrixnge
_MatriDeme:ngc)
&3] desktop.ini [

‘Left click’ & ‘Hold’

T
P
2235K8 P
N
N

‘Drag’to Linux drive

[ Desktop - machinekit@192.168.7.2 - WinSCP

Local Mark Files Commands Session Options Remots Help

[FF &2 3 synchronize Bl F [ @ [ (5 Queue ~ ° Transfer Settings Default - @
[ machinekit@192.1627.2 G New Session
[ Desktop -EE g % ie- nc_files -BE

E Upload [ | [ Edit 3 o) [ Properties | £ [ ]

C:\Users\lanF\Desktop /home/machinekit/nc_files
Name Bt Size Type Changed Name Bt si
H. Parent directory 06/11/2017 02:50:7 [ e .

i MicroCNC Assembly Instructions - M... 2235KiB  PDF File 02/11/2017 12:12:7) examples
44418 NGCFile 12/09/2017 10:39:2) share
65,5688 NGCFile 14/07/2017 12121 | || MatrixDemo.ngc 65,568

Configuration sett... 02/11/2017 08:1%:()

| Miatrixh.ngc
itriDemenge;

S

L] desl

X

Eile Machine Wiew User Help

@0 og vou@iiue=2zNX¥PpE b
Manual Control [F3] ]MDI IF5] | Preview IDRo 1
Axis; i 9]

] =]

Directory:  fhome/machinekit/nc_files

1 examples
7 share

[EfMatrikDemo.ngc

Feed Override: 1

Jog Speed: 126 mmymi || ]
Jog Speed: 126 deg/m|  fjle name: [MatrixDemo.ngc Open
Max Velocity:

3000 mm/|

Files of type:  All machinable files (*.nge,%py)  — Cancel ‘

1: (Building Brick
2: (zero point: Y-
2. (setting zero point: rotate A-axis until surface is ewen, move the tip of the endmill to t

[~ Show Hidden Files and Directories

4: (right end of the foam block, to the middle on ¥-axis and)
. (then move down on the Z-axis until you almost touch the material.)
: (now home all axis)
i (turn down the feed override to 40%, then start, after a while you can turn feed override
back to 100%) i

|EsTop [Ne tool

Position: Relative Actual



This example project will show how to create a simple part on the Matrix MicroCNC Lathe. The part was first
designed using a typical CAD package, Solidworks in this case, and then converted to a .dxf file. A typical
CAM package, CAMBAM in this case, was then used to generate the G-Code used by the Matrix MicroCNC

Lathe.

The images opposite show the 2D sketch, and 3D
Model, of a part to be turned on the MicroCNC Lathe.

First save the sketch file as a “dxf’ file; this type of
file can be imported into most CAM software
packages, and will enable G-Code to be generated
automatically from the drawing.

Open your sketch file and then select ‘File Save As'.
In the ‘Save As’ window make sure you save the file
type as Dxf (*.dxf).

Usually you can use the default settings for the Dxf
file, however you may need to select which features
are used to save the file.

For this part in Solidwork the default settings can be
used; click‘OK’ to continue.

Most CAD packages will then give the option to
remove any parts of the sketch that have been
included but are not required.

In this example the centre line and the two end
faces are not needed so could be removed here by
selecting them and clicking the ‘Remove Entities’
button then saving the file.

However, for this example these will be removed in
the CAM software.

asecists |

Hel

Bt | Smart
Sketch | Dimension

Features | Sketch [ Make Drawing from Part

P——————— B | Make Assembly from Part
S (B[S :

@d [ | save

' works image 1A ( [ | savess

el &P | Save Al I}

Page Setup.
[l | Print Preview..
ec

Ctri+s

Mi
Lir
M

P-o @@

et oy
BB - werkonest mage 14 e,
DXF/DWG Outper

]

e

o B8




This project example is using the ‘Example Part -Lathe 001.dxf’ file generated in Solidworks, and described
previously; most CAD and CAM software packages can work with Dxf files.

Open a Dxf file in the CAM package you are using.
The sketch is imported as a single layer containing
several lines.

This imported sketch will need editing before the
G-Code can be produced.

In this example the image that has been imported
needs to be edited to change the orientation so the
sketch is in the +X and -Y orientation.

It will also need to have three of the lines removed
otherwise the CAM software will try to create a
cutting path for the two ends and the centre line.

Select the sketch by ’Left Clicking’ and ‘dragging’ a
box around the shape as shown opposite, all the
lines will be selected as shown:

SelectEdit’ ‘“Transform’ ‘Mirror’ from the menu.
Select two points on the X Axis (mirror line), a
mirror image of the original sketch is created in the
correct orientation required to produce G-Code for
a turning (Lathe) operation.
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The sketch needs further editing to remove the
‘Original’ sketch, the two end faces of the new
sketch, and the centre line. Again, select all the lines
in the original sketch by’Left Clicking’and ‘dragging’
a box around the lines; any lines not fully inside the
selection box will not be included.

The two end faces are then selected by holding the
‘Ctrl’ key and ‘Left Clicking’ each line individually.
There should be 11 lines highlighted and 5 lines
unselected as shown opposite.

The selected lines can be deleted using the ‘Delete’
key, 'CTRL+X, keys, or by selecting ‘Edit -> Cut

The remaining lines now need to be Joined’ to
create a continuous polyline.

Select the lines as before and then ‘Join’ them by
selecting ‘Edit -> Join’ enter a tolerance of 0.01.

A single polyline will be created as shown opposite:

Parameters need to be entered for the stock size,
offset and surface, type of Post Processor*, and tool
profile*
*(Depends on
performed).

In this example these values are set as shown
opposite.

The stock used is a machining wax cylinder with
dimensions 70mm X @28mm. The ‘Stock Size’
entered is X =70,Y =28, Z = 28.

The 'Y’ off value of -14 and the ‘Stock Surface’ value
of 14 centres the stock along the central axis of the
part to be machined, as show below (the piece of
stock is represented by the orange box).

machining operation to be
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After entering the ‘Machining’ parameters the
next stage is to define the cutting path. However,
before this can be done it may be necessary to
make adjustments to the position of the stock in the
machine, or the position of the part within the stock.
In the screen shot below the example part is to be
machined from a piece of stock slightly larger than
the part (partlength =60mm, stock length =70mm).

Space required by chuck
jaws

wup fap Fheas ek b
~UU NEdRENE sa3uUa

The reason for this is that the stock has to be held in
the lathe by the chuck; and the chuck’s jaws extend
9.4mm from the chuck face.

It can be seen from the image below that the cutting
path falls inside the area used by the chuck jaws to
hold the stock, if the example part is machined ‘as
is’the cutting tool would damage the chuck or vice
versa.

In this example the cutting path needs to be moved clear of the chuck jaws

Select the polyline as before, then select ‘Edit ->
Transform -> Move' from the menu.

Pick a point on the line and move to the opposite
end of the stock as shown, take care not to move the
polyline up or down.

Select the line as before then from the menu select
‘Machining -> Lathe’

This will create Part1 and Lathel operation under
the under the machining parameters as shown:

Select the Lathe1 operation then check and set the
following parameters

Check the ‘Primitive IDs’ match the Polyline of your
part, in this example it is 17, there should be no
other lines included.
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Note: the following settings are for the Example
Part - Lathe 001 Only.

Clearance Plane - set to 15mm, this ensures the
cutting tool is moved clear of the stock as it finishes
one cut and moves to the next.

Depth Increment - set to 0.4mm, this is how deep
the cutting tool will cut into the stock material at
each pass.

Stock Surface - set to 14mm, this is the radius of our
stock.

Cut Feedrate - set to 500, this sets the speed of
travel of the cutting tool along the workpiece, larger
values move the tool quicker. Harder materials need
to be cut at slower speeds.

Plunge Feedrate - set to 150, this is the speed that
the cutting tool is fed into the material, again harder
materials require a slower speed.

Work Plane - select 'XZ' from the drop down menu,
this sets the axis for the lathe operation as shown
previously the X-Axis cuts into the material towards
the axis of rotation, the Z-Axis cuts along the length
of the part.

Lathe Cut Direction — select ‘Right Hand’ from the
drop down menu, a right hand tool cuts from right
to left, in this example we are cutting the stock from
the end towards the chuck.

Roughing / Finishing - select ‘Roughing’ from
the drop down menu, a roughing operation will
‘roughly’ cut the stock to size, slightly larger than
the finished dimensions. It is possible to include
additional cutting operation one after the other;
for example, a finishing operation could follow a

After parameters have been set for the Machining
and Lathel operation a tool path can be generated.
Select ‘Machining -> Generate toolpath’ form the
menu. The blue lines show individual cutting paths
and the yellow arrows indicate the cutting direction.
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roughing operation, parameters would need to be
set independently for each operation.

Tool Profile - select ‘Lathe’ from the drop down
menu.

The two images below show how the number of cutting paths reduces as the depth increment is increased:

Bl (General) A

500
150

Depth Increment = 0.25mm

B (General) A

500
150

Depth Increment = 2mm



After checking the toolpaths are correct G-Code can
be produced.

Select’Machining -> Produce gcode’from the menu
and save the file to a suitable location.

The G-Code can be checked by either selecting
‘Machining -> Edit gcode’ from the menu or by
opening in a text editor program such as‘Notepad’

From the MATRIXCNC drive select and open the
‘Launch_File_Transfer.bat’ program.
Click ‘Login’to continue.

Navigate through the Windows Drive to the location
the CAMBAM generated G-Code file was saved.
‘Left Click’ and ‘Hold;, then drag the file to the Linux
drive on the left. A copy of the file will be created in
the new location, as shown below.
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After transferring the
G-Code file to the Linux drive select and open the
‘Launch_2AXIS_LATHE.bat’ batch file as described
previously.

This will open the Lathe control program.

After the control program has launched open the
‘Example Part — Lathe 001.nc’ file by selecting ‘File
-> Open’ from the menu, in the ‘Open’ window click
on the ‘File of type: drop down menu and select
‘All Files(*). Select the file and click ‘Open’ as shown
below.

The file will be opened with the G-Code available
to view in the lower window, there will also be an
image showing the cutting paths to be machined,
as shown below.

Application Teals  MATRIXCNC () - o X
yyyyy Share  View Manage

= » ThisPC > MATRIXCNC ()

Launch_2AXIS_LATHE
Windows Batch File

autorun
Launch 2AXI5_LATHE
Leunch_3AXIS_ MILL
Laun
La

‘i Local Disk (C)

= 32GBUSB (D)

= MATRIXCNC (E)

= 32GB USE (D)

X

Axis

ESTOP

File Machine View User Help
= S
=ES

Manual Control [F3] | MDI [F5]

Qr

Feed Override:
llog Speed
Max Velocity: 3000

>opuif@(Tfon |+ =¥

Preview | RO

-0.000 DTG R:
Al -0.000
H -0.000

0.000

DTG Z: 0.000

X open .000
Directory:  Jhome/machinekit/nc_files
£1 examples

1 share
B MatrixDemo.nge

126 |
File name: open

| Files of type: Al machinable files (*.ngc.*.py)
Show Hidde All machinable files (*nge,* py)

Cancel

921
g7 (activate

O3 516000 rs274nge files (%.nge) -
g0 x20 Python Script (*py) X
q0 z1
0 x11.8 . . =
gl 2-20 f100 Directory:  /home/machinekit/nc files
gl x12 z-21

No tool Fosit |01 examples

£ share

[ERExample Part - Lsthe 001.nc
B MatrixkDemo.ngc

| File name: Example Part - Lathe 001.nc Open [
Files of type:  All files (%)

[ Show Hidden Files and Directories

Cancel




Before inserting the stock into the lathe the cutting tool should be ‘Homed'’ as described earlier, see Lathe
Assembly - Step 4. Once the cutting tool has been aligned with the centring bit the X and Z axes need to
be homed in the control program. Refer to the previous section for operational instruction for the control

software.

Select each axis in turn and click the ‘Home Axis’
button.

When an Axis has been homed it will have next
to the value.

Once each axis has ‘Homed’ or zeroed, move the
cutting tool using clear of the stock. This should be
done using the control program, not by manually
turning the jog wheels. Set the movement to

Preview | pRo

File Machine Wiew User Help kPreview | pRO

Rad: 1.546
QB =& b=»iEa Dia: 3.091
Manual Control [F3] | MDI [F5] Z: -2.888
Axis; & X z Un-homed

+ ||Continuous -
Preview | DRO

Home Axis Touch Off

Homed

‘Continuous’ and use the ‘+' button to move the
cutting tool along the Z-axis approx. 70mm and the
X-axis approx. 18mm, as shown below.

Turn the Controller Base Plate power off using the
Main IEC switch; this will not affect the homed
settings of the lathe provided the axes are not

moved. With the power off, place the stock into the
lathe as shown below. Note the clearance between
the cutting tool and the stock.



After setting up the stock the power can be restored
to the Controller Base Plate. Ensure both the
‘Physical’ and software emergency stop buttons
are disengaged and apply power to the lathe as
described below. Start the DC Motor using the
switch on the side of the Controller Base Plate.

To operate the stepper motors, disengage the
software’Emergency Stop, then turn onthe’Machine
Power’; the axes selection radio buttons and the
stepper motor controls will then be enabled.

With the DC motor running and the stepper motors
energised start the cutting program by clicking the
‘Play’ Button as shown opposite.

When the machining process has ended the cutting
tool stop at Z = 10, X = 30; move the cutting tool
using clear of the stock as previously. Turn off the
power to the motors as before and remove the
finished piece from the lathe.
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